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Instructional Design 
 
This Self-Study course is designed to lead you through a learning process using instructional 
methods that will help you achieve the stated learning objectives. You will be provided with 
course objectives and presented with comprehensive information and facts demonstrated in 
exhibits and/or case studies. Review questions will allow you to check your understanding of the 
material, and a qualified assessment will test your mastery of the course.  
 
Please familiarize yourself with the following instructional features to ensure your success in 
achieving the learning objectives. 
 
Course CPE Information 
The preceding section, “Course CPE Information,” details important information regarding CPE. 
If you skipped over that section, please go back and review the information now to ensure you 
are prepared to complete this course successfully. 
 
Table of Contents 
The table of contents allows you to quickly navigate to specific sections of the course. 
 
Learning Objectives and Content 
Learning objectives clearly define the knowledge, skills, or abilities you will gain by completing 
the course. Throughout the course content, you will find various instructional methods to help 
you achieve the learning objectives, such as examples, case studies, charts, diagrams, and 
explanations. Please pay special attention to these instructional methods, as they will help you 
achieve the stated learning objectives. 
 
Review Questions 
The review questions accompanying this course are designed to assist you in achieving the 
course learning objectives. The review section is not graded; do not submit it in place of your 
qualified assessment. While completing the review questions, it may be helpful to study any 
unfamiliar terms in the glossary in addition to course content. After completing the review 
questions, proceed to the review question answers and rationales. 
 
Review Question Answers and Rationales 
Review question answer choices are accompanied by unique, logical reasoning (rationales) as to 
why an answer is correct or incorrect. Evaluative feedback to incorrect responses and 
reinforcement feedback to correct responses are both provided. 
 
Glossary 
The glossary defines key terms. Please review the definition of any words you are not familiar 
with. 
 
Index 
The index allows you to quickly locate key terms or concepts as you progress through the 
instructional material. 
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Qualified Assessment 
Qualified assessments measure (1) the extent to which the learning objectives have been met and 
(2) that you have gained the knowledge, skills, or abilities clearly defined by the learning 
objectives for each section of the course. Unless otherwise noted, you are required to earn a 
minimum score of 70% to pass a course. If you do not pass on your first attempt, please review 
the learning objectives, instructional materials, and review questions and answers before 
attempting to retake the qualified assessment to ensure all learning objectives have been 
successfully completed. 
 
Answer Sheet 
Feel free to fill the Answer Sheet out as you go over the course. To enter your answers online, 
follow these steps:  

1. Go to www.westerncpe.com.  
2. Log in with your username and password. 
3. At the top right side of your screen, hover over “My Account” and click “My CPE.”  
4. Click on the big orange button that says “View All Courses.”  
5. Click on the appropriate course title.  
6. Click on the blue wording that says “Qualified Assessment.”  
7. Click on “Attempt assessment now.”  

 
Evaluation 
Upon successful completion of your online assessment, we ask that you complete an online 
course evaluation. Your feedback is a vital component in our future course development.  
 
 

Western CPE Self-Study 
243 Pegasus Drive 

Bozeman, MT 59718 
Phone: (800) 822-4194 

Fax: (206) 774-1285 
Email: wcpe@westerncpe.com 
Website: www.westerncpe.com 

 
 
 
 
 
 
 
 
 
 
 
 
Notice:  This publication is designed to provide accurate information in regard to the subject matter covered. It is 
sold with the understanding that neither the author, the publisher, nor any other individual involved in its distribution 
is engaged in rendering legal, accounting, or other professional advice and assumes no liability in connection with 
its use. Because regulations, laws, and other professional guidance are constantly changing, a professional should be 
consulted should you require legal or other expert advice. Information is current at the time of printing.

http://www.westerncpe.com/
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Excel Worksheets: Best Practices  
 
Learning Objectives  
Upon successful completion of this course, participants will be able to: 

• Recognize worksheet layout and design best practices, noting Excel features that promote 
data clarity 

• Identify the various Excel features that help audit worksheets and ensure calculation 
accuracy 

• Recognize the defining characteristics and usage of data validation tools, cell and 
worksheet protection, workbook protection, formula auditing tools, error checking, and 
tracking changes 

 
Course Overview 
Excel worksheets and workbooks are commonly considered “number crunching” tools. The 
focus is getting data into a worksheet, performing a few calculations, and arriving at an answer 
as quickly as possible. This mindset, while prevalent, ignores many of the real goals and needed 
controls over worksheets that make them decision useful tools. 
 
Worksheet layout for clarity 
Worksheets are used as a tool to make decisions. Accordingly, the results of the worksheet 
should be easily understood and not subject to misinterpretation. The overall layout and design 
of the worksheet is important to its usefulness as a management decision tool. The worksheet 
reader, as well as its author, should have no doubts regarding the data inputs, the calculations 
being performed, and the resulting output. 
 
Worksheets are important financial tools and are used in very complex calculations with very 
large numbers. If there is any misunderstanding regarding the data inputs being used, the 
calculations being performed, the assumptions used, or the output it could result in very large 
financial or operational errors. Having an effective worksheet layout is the first step in 
minimizing the possibility of any worksheet error.  
 
Aspects of worksheet layout that accomplish the clarity objective include: 

• naming the worksheet with an appropriately descriptive name 
• having descriptive worksheet headings as well as descriptive row and column headings, 

and 
• segregating the data inputs, assumptions, calculations, and output. 

 
One additional important, yet generally disregarded practice, is to make sure that the worksheet 
is documented with comments and other notations to ensure that a reader of the worksheet will 
understand the source of the data, the methods employed, and the intended use of the worksheet. 
Note that these explanatory comments and notations also help the preparer of the worksheet to 
remember what was being accomplished and how it was being accomplished if the particular 
worksheet is infrequently used. 
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Worksheet design to improve calculation integrity 
There are aspects to the design of a worksheet that help ensure that the results of calculations are 
correct. For data inputs, it is important to have a check total (or totals) that can be compared to 
another authoritative data source to ensure that the correct input data is being used. Remember, 
garbage in, garbage out. If the wrong data is being used, then the resulting output will also be 
incorrect. 
 
There are also other design conventions that help preserve the integrity of the output. These 
include always using cell references in calculations rather than numbers and using constraint 
calculations to highlight outliers. 
 
These design conventions will be described in much greater detail later in the course. As an 
overview, the use of cell references makes it easier to modify assumptions and decreases the 
likelihood of error. As an example, if the goal of a worksheet was to forecast quarterly sales over 
the next two years using an assumed percentage growth rate, it would be much more controlled 
to have that percentage growth rate spelled out in a range of cells and have the formulas use the 
cells to calculate quarterly sales rather than to embed the percent growth rate into each formula 
that calculated quarterly sales. If the percentage were embedded, it would be up to the worksheet 
preparer to edit each formula with a new percent. If a user wanted to ensure that the correct 
percentages were utilized, they would be required to review every formula. That, in addition to 
the heightened possibility of input error, make this an undesirable method. By using a separate 
range of cells, changes may be made quickly and accurately with easy review by others. 
Using constraint calculations is another way of saying the “sanity tests” should be embedded in 
the worksheet. If the intent of a worksheet is to predict G&A costs relative to the prior year, you 
may want to include a constraint calculation that compares the forecasted amount to the prior 
year amount and highlights any increases greater than 10%. This provides an easy way to test 
worksheet results. Methods to highlight based on constraint calculations will also be discussed in 
more detail later in the course. 
 
Worksheet audit and other tools to ensure accuracy 
The goal of all calculations is that they are accurate. Excel provides some great tools to ensure 
that calculations are performed as intended. These tools include data validation, formula 
auditing, worksheet and cell protection, workbook passwords, and a seldom used but neat feature 
on the Home toolbar called Go To Special. 
 
These tools can be used to ensure that the worksheet or workbook is not changed by an 
unauthorized person (i.e., passwords, cell, and worksheet protection), the assumption or other 
user inputs in the worksheet are confined to an acceptable range of values (data validation), and 
the formulas are functioning as intended (formula auditing). Go To Special is extremely helpful 
in quickly finding and highlighting formulas in the worksheet to make review easier. 
These areas will be explored and discussed as best practices in Excel Worksheets.  
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Worksheet Layout 
 
Name the Worksheet 
While it may seem intuitive, this is a step that many professionals skip. It is important to name 
the worksheet on the worksheet tab with something meaningful and descriptive as a reminder to 
both the preparer and other users of the worksheet or workbook of the intended use of the 
worksheet. This is especially important if you are using a workbook with multiple worksheets. 
As an example, if a workbook’s intent is to accumulate inventory values at standard cost and one 
worksheet contains the results of physical inventory quantities by unit and another worksheet 
contains the standard cost for each unit, it is important that the worksheet tabs be labeled 
something similar to “Physical Inventory” and “Standard Costs”. Otherwise, the user of the 
worksheets may draw a different conclusion as to what the data represents. 
 
Using another example, if a workbook’s intent is to provide a sales forecast and one worksheet 
has historic quarterly sales results and another has growth assumptions, these worksheets should 
be labeled “Historic Qtrly Sales” and “Growth Assumptions.” As the first thing that the user of 
reader of the workbook will look at when opening the workbook are the worksheet tabs, this 
helps in understanding the intent of the worksheets and avoids misinterpretation of the data. 
 
Use Headings 
Headings provide another description of the intent of the worksheet. Generally, more space is 
available, so any description can be longer than that used as a worksheet name. Headings can 
also clarify the source of any data. 
 
To continue the examples above, if a workbook’s intent is to accumulate inventory values at 
standard cost and one worksheet contains the results of physical inventory quantities by unit, an 
appropriate heading may be “Physical Inventory Quantities by Part No. as of XX/XX/XXXX.” 
This is more descriptive than the worksheet name “Physical Inventory” as it also describes that it 
represents quantities by part number as of the physical inventory date. Both the preparer of the 
worksheet and any user should not have any misinterpretation of the source and type of data that 
is represented in the worksheet. 
 
Within the same workbook, if the other worksheet contained standard costs, an appropriate 
heading would be “Standard Inventory Costs as of XX/XX/XXXX.” Once again, the headings 
should describe the contents of the worksheet for both the preparer and the reader. 
 
When it is emphasized that names and headings are important for the preparer, this may cause 
some to ask the question, “Why should I worry about these things if I will be the only user of the 
worksheet/workbook?” Well, if you prepare more than a few worksheets or workbooks during 
the course of the year, it is likely that you have returned to one after a while and had some 
difficulty remembering either (a) what you were trying to accomplish, (b) the source of the data, 
or (c) why you prepared the worksheet/workbook in the first place. So, these conventions are just 
as important for you the preparer, as they are for a third party who is trying to understand the 
contents and result. As a practical matter, think of the person trying to perform your job tasks 
while you’re on vacation or the person replacing you when you’re promoted. 
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Use Descriptive Column and Row Headings 
Each column or row of data should be adequately described for the same reasons cited above. 
Both the preparer and reader need to know the source of the data, assumptions, calculations 
being performed, and the output. Proper organization avoids confusion. 
 
If there are two columns of data and one represents a stock number and the other represents 
standard cost, these two columns should be labeled “Stock #” and “Std. Cost” respectively (or 
some easily understood variation).  
 
If data is organized in rows, and the first row represents Sales and the second represents Cost of 
Sales, these should be the row labels. If quarters are represented in the columns, each column 
should be labeled with the appropriate quarter and year (e.g., Q1, 2015). 
 
Segregate Data, Assumptions, and Calculations 
Some compare a spreadsheet to a computer program. A computer program has three basic 
components: input, processing, and output. For a worksheet, it would be better to describe these 
functions as input, assumptions, and output as worksheets and workbooks are often used in 
“what if” scenarios to aid in management decision making. Separating these tasks in a worksheet 
or workbook will minimize the possibility of error by permitting review of each component. 
The easiest way to illustrate the advantages of this best practice, and the pitfalls of not using it, is 
through example. Two examples follow. 
 

 
 
This is a quarterly sales forecast based on prior year actual sales. It simply takes the prior year 
actual quarterly sales and increases each quarterly amount by 20% (multiplies by a factor of 1.2). 
What are the downsides to this worksheet? 

• Neither the preparer nor another user can tell that each quarter’s forecasted sales should 
increase by 20%. 

• In the event of a change to the 20% assumption, the change would need to be made to 
each cell and, once again, neither the preparer nor the reader can easily ascertain the 
growth assumption. 

• To easily tie out the input (Actual Sales), there should be a total. 
• It would be easier to read if there was some separation between Actual Sales and 

Forecasted Sales. 
• There is no heading on the worksheet. 
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To summarize, the biggest problem with the worksheet above, is that there is no separate 
documentation of assumptions being used and no separate calculation using those assumptions. 
A separation of the assumptions used permits both the preparer and the reader to easily review 
and understand the basis of the underlying calculations. Additionally, having the assumptions as 
the basis for the calculations also prevents errors when the assumptions are changed as the 
changes are evident on the worksheet. 
 
Lesser problems are that the data inputs (Actual Sales) could be more easily tied to annual sales 
if there was a total. Without the total, the preparer is relying solely on a comparison to each 
individual quarterly amount. Another is that there should be some separation of the output 
(Forecasted Sales). This separation would let a reader know the intent of the worksheet as would 
a worksheet heading. 
 
A suggested revised format for this worksheet follows and may be found in the Worksheet Best 
Practices workbook on the tab labeled Good Sales Fcst. 
 

 
 
In the above example, the growth assumptions are clear and easy to change. Since the 
assumptions in H5:K5 are the basis for the Forecasted Sales calculations, changes are both 
transparent to the preparer and reader and there is more assurance that the changes will be 
reflected in the calculations. 
 
There is also a descriptive heading and a separation of the output for the benefit of a reader. 
Actual sales are totaled for ease of comparing this amount to an authoritative source. This 
worksheet can be handed to a third party reader and it is more likely that the reader can 
understand the intent of the document as well as challenge the input and assumptions being 
utilized. 
 
This format also benefits the preparer. If the preparer were asked to change the quarterly growth 
assumptions to Quarters 1-4 to 10%, 15%, 20%, and 25%, respectively, this would be a matter of 
simply entering the new assumptions in cells H5:K5. Using the previous worksheet, the preparer 
would have to edit four formulas and the reader would likely need to re-check the amounts to 
ensure that the proper growth assumptions were used. 
  
Another example would be the case of a worksheet whose intent is to use prior year actual 
accounts receivable information and certain assumptions as a basis to forecast the current year 
Allowance for Bad Debts. The assumptions for the current year are the acquisition of new 
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customers that will boost sales and also boost accounts receivable to an end of year balance of 
$9,000,000. However, it is also expected that the increase in sales will result in more 
delinquency. The 0-30 aging category is expected to increase to 20% of total accounts 
Receivable while the 31-60, 61-90, 91-120 and 120+ aging categories are expected to increase to 
15%, 5%, 2% and 1% respectively.  
 
The worksheet used for forecasting the current year Allowance for Bad Debts follows. 
  

 
 
The positive aspects of this worksheet are: 

• The worksheet has a descriptive heading 
• Rows and columns have appropriate headings 
• The actual accounts receivable and allowance can be tied out to appropriate amounts  
• The output (Forecasted Allowance) is separated from the inputs 

 
However, there are a few negative aspects. These include: 

• There is no way of knowing the basis of the Forecasted Allowance. The assumptions 
used for accounts receivable balance, associated aging, and allowance calculation 
percentages are not evident. 

• The missing assumptions are embedded in the calculations in C14:G14. 
• Without transparency of the assumptions and calculations, a preparer or reader of the 

worksheet may arrive at an incorrect conclusion if there is an error in the calculation or if 
any assumptions differ from those being used in the worksheet. 

 
Transparency is the key to proper worksheet layout. Data inputs, assumptions, calculations, and 
outputs should be evident. It should be easy for the preparer and the reader to challenge and 
understand all elements of the worksheet so that bad decisions are not the results of a poorly 
constructed worksheet. 
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An improved worksheet layout is found below and may be found in the Worksheet Best 
Practices workbook on the tab labeled Good AR Aging. 
 

 
 
This worksheet overcomes the negative aspects of the previous example. The actual amounts 
remain the same. However, the basis of the forecast is now evident. Aging assumptions are set 
forth in a distinct area. These assumptions are used as the basis to calculate the accounts 
receivable aging. The allowance calculation percentages are also set forth, making them easy to 
review.  
 
The improved layout and additional information make the worksheet more transparent and less 
susceptible to error. This layout has a much lower possibility of making a bad decision due to a 
poor understanding of the assumptions, calculations, or worksheet intent. 
 
Absolute Cell References 
Let’s take a look at the formula in cell C16.  
 

 
 
Why the $ signs? These are called absolute cell references. When you use these, the cells will not 
change when they are copied. These can either be typed manually, or inserted after each cell 
reference by pressing F4 on your keyboard and the $ signs will be inserted.  
 
The reason for the absolute cell references is that we want to use the 9,000,000 in cell H16 and 
multiply this amount by the aging assumptions in cells J18:O18. If a formula in cell B16 was 
copied to cells C16:G16 without using absolute cell references (the $ sign), the referenced cells 
would change by one cell to the right with each copied cell. So, if cell B16 multiplied cells H16 
by J18 and this was copied to cell C16, the resultant formula would be I16 multiplied by K18. To 
keep the H16 cell reference from changing (that’s where the 9,000,000 is), use an absolute cell 
reference (the $ signs) so that the cell does not change from H16 as it’s copied across.  
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Absolute cell references prevent the cell references from changing as they are copied. However, 
the cell references that are not absolute (they are relative), change as the formula is copied. 
This can be taken one step further. You can prevent either the row reference or the column 
reference from changing by only using one $ sign rather than two. Using the same example, if 
the cell reference for H16 was indicated as $H16 in a formula, this would indicate that if the 
formula were copied across, the H column would not change because it is absolute (contains a $ 
sign) and, since it’s being copied across, the 16 row indicator would not change either. However, 
if the formula using the cell reference $H16 was copied down, the reference would change from 
$H16 to $H17 as there is no absolute cell reference before the row indicator.  
 
Named Ranges 
An easier way of dealing with cell references and ranges of cells is to use the Name Manager in 
Excel. Using this tool, you may name an individual cell or name a range of cells. When either a 
cell or range of cells is named, the absolute reference of that cell is preserved, obviating the need 
for the absolute cell references. 
 
A big advantage of named ranges is that they are already absolute cell references in formulas. 
Another advantage is that a name for a cell or range of cells is much easier to remember. As 
demonstrated in the example below, it is much easier to remember a cell named “Q1” than it is to 
remember a cell labeled H5. 

• Open the Worksheet Best Practices workbook and select the tab labeled Good Sales 
Fcst. 

 
To name cell H5 Qtr_1, select cell H5 in a worksheet. To name the range, go to the Formulas 
menu and select Name Manager from the toolbar. 
 

 
 
When Name Manager has been selected, a dialog box appears. 
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Click the New…  button at the top. 

 
 
Name the cell Qtr_1. Note that the named range relates to cell H5 in a worksheet that has been 
labeled Good Sales Fcst. Also note that there are $ signs in the range, indicating that it will be 
absolute. 
 
Once the Qtr_1 has been entered, press OK. 
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Cell H5 is now labeled Qtr_1. Press the Close button. 
 
It is now possible to reference Qtr_1 in a formula. In cell B8, rather than having the formula be 
=B5*(1+$H$5), it may now be =B5*(1+Qtr_1) 
 

 
 
In this instance, the named range cannot be copied across since it is completely absolute. If it 
were copied, all the quarters would use the Qtr_1 growth assumption. This convention is very 
good for referencing one absolute cell or range of cells and makes the input very easy to 
remember. However, if you do need to copy the formula down or across, it will not automatically 
adjust since the reference in completely absolute (just like using $H$5). 
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In this example, it would be a good idea to name I5:K5 as Qtr_2, Qtr_3, and Qtr_4, 
respectively and adjust the formula references in C8:E8. 
 
There are some naming conventions for named ranges that you should keep in mind. Names 
must begin with either a letter or an underscore. Only letters, numbers, underscores, and periods 
can all be used after the first character. Spaces cannot be used. 
 
 Correct Name    Incorrect Name 
 Total_Expense    Total-Expense 
 Net_Income     Net Income 
 Year2010     2010 
 Q_1      Q1 
 
The last one may be a little tricky. Why is Q1 an incorrect name? Because it refers to an existing 
cell reference in the worksheet. Keep in mind that worksheets are getting bigger. You wouldn’t 
be able to name a range Tax09 as this is also an existing cell reference in the worksheet. 
 
To name a range of cells, first, select the range. As an example, the range of B8:E8 is summed in 
cell F8. Select the range B8:E8. 
 

 
 
Select Name Manager and name this range Q1_Q4_Sales_Forecast. 
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Note that the range being referred to is $B$8:$E$8. Press OK. 
 
Now, when this range of B8:E8 is selected, it is referred to as Q1_Q4_Sales_Forecast. 
 

 
 
Naming key cells and key ranges of cells is a best practice. The advantages are that the named 
ranges are absolute in nature (when you use Qtr_1, it will always refer to the Quarter 1 growth 
assumption). This absolute nature helps to minimize the impact of keypunch errors or erroneous 
cell references in formulas. The other advantage is that named ranges are much more descriptive 
for a reviewer and much easier to remember for everyone. 
 
Document Data Sources and Key Calculations Using Comments 
Proper documentation is essential to ensure that users understand how the worksheet functions 
and what it is intended to do. Excel provides for comments that relate to each cell. These 
comments are displayed as the cursor hovers over the cell and can also be displayed through a 
command. Excel comments are an excellent way to document the worksheet as the 
documentation is contained within the spreadsheet and is not a separate document that is unlikely 
to be consulted. 
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To add a comment to a cell, open a new worksheet and  
• Go to the Review tab. 
• Click New Comment. 

 
 

 
 
When New Comment is clicked, you have a yellow area (white input box in newer excel 
versions) to add text.   

 
 
Within this area, you can describe the particular cell input or use it to provide overall information 
about the spreadsheet. The area can be resized larger or smaller by dragging the corner with your 
mouse. 

• As an example, in cell A1, type “The purpose of this worksheet is to provide an example 
of documentation.” 

 

 
 
When the cursor hovers over this cell, this comment will be displayed. You can also display the 
comments using the Previous Comment and Next Comment buttons as well as display all 
comments by clicking on Show Comments. 
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Also note that comments can be edited and deleted with a click of the mouse. 
You can also right-click on a cell and select Insert Comment (New Comment on newer Excel 
versions)  
 
Comments can help the preparer and reader understand the source of the data used (so that the 
analysis may be replicated in the future) and the rationale for assumptions as well as explain how 
calculations work. 
 
Using the Forecasted Quarterly Sales example, appropriate comments may be: 
 

 
 
These were obtained by using the Show All Comments option in the Review tab. 

• Try adding comments to the Good Sales Fcst tab of the Worksheet Best Practices 
workbook. 

 
For the preparer, comments can be thought of as a “cheat sheet” to remind them of the data 
source, assumption source, and components of calculations. For the reader, they can help in both 
reviewing and understanding worksheet components. 
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It is also possible to print out the comments as part of the worksheet. When preparing the 
worksheet for printing, select Print and click on the Page Setup link (located at the bottom under 
the No Scaling options). 
 

 
 
In the page setup window, select the Sheet tab. 
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On the middle portion of the right side of the dialog box are the Comments options. You may 
elect to either print the comments at the end of the sheet or print them as displayed on the 
worksheet. A word of caution, printing the comments as displayed on the worksheet may obscure 
some of the output. 
 
Multiple Worksheet Workbooks 
In instances where the data or analysis is large, multiple worksheets should be utilized as part of 
a workbook. In these cases, all worksheet tabs should be appropriately labeled and each 
worksheet should contain appropriate overall headings as well as row and column headings.  
The separation of the input data from the assumptions, calculations, and the output should be 
accomplished on separate worksheets. As an example, assume that the input data is prior year 
sales by model and embedded in each model number is one of five product lines. You are asked 
to apply a specific sales growth factor to each product line to forecast current year sales. 
 
In this case, there should be one worksheet for the input data that may, as an example, be labeled 
“PY Sales by Model.” There should also be a worksheet that may, as an example, be labeled 
“Growth Assump. By Prod. Line.” Another worksheet should be used to summarize prior year 
sales by product line and apply the growth assumptions. This worksheet may be labeled 
“Calculations.” The last worksheet, for your output, would contain a current year sales forecast 
by product line, based on prior year sales and growth assumption and may be labeled “Sales 
Forecast.”  
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Another example is the use of an Excel workbook to compile monthly and annual financial 
information. It may be organized by financial statement line item so that each line item has its 
own worksheet that is broken out by month. Revenue and expense detail can be entered into the 
appropriate month and the totals for each month are linked to a summary worksheet. By 
organizing it in this manner, the inputs (each worksheet of detail) is separated from the output 
(the summary worksheet). An example is below and is also contained in the Worksheet Best 
Practices workbook with worksheets labeled as Summary Worksheet, Revenue, and General and 
Admin Expenses. 
 

 
 

 

 
 
This method ensures information organization and clarity for both the preparer and reader.  
 
Headers and Footers 
Headers and Footers are only evident on printed pages. If a worksheet or workbook is meant to 
be shared, using the first row(s) of the worksheet may be a better alternative as the heading will 
appear on the worksheet being displayed on the computer monitor. A discussion of how to use 
Print Titles to achieve the same title on each of multiple printed pages will appear after this 
discussion. 
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The use of headers in a worksheet is a good way of ensuring that each printed page has the same 
heading. Headers use a portion of the top margin of a printed page to print a consistent heading. 
If you elect to use a header rather than the top row of a worksheet, this option is found under the 
Insert menu option, then selecting Header & Footer toward the right side of the taskbar. 

• Open a new worksheet. 
 

 
 
After selecting the Header & Footer option, a new worksheet layout appears as well as a Header 
& Footer Tool Design menu option at the top. 
 

 
 
You may either type in test as a Header or use one of the standard headers under the Header 
button on the left side of the toolbar. These options are generally page numbers, workbook name, 
and date, etc. 
 
In this case, we’ll use Test Header as an example. Simply type this text into the box. 
 

 
 
This text may be altered like any other text. You may make it larger, bold, italicized, or 
underlined.  
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Click anywhere within the worksheet and the Header will be saved. 
Notice that you’re still in a Page Layout mode in the worksheet. To return to the Normal page 
layout, click on the View menu option and select the Normal option on the left hand side of the 
toolbar. 
 

 
 
Once back in the Normal page layout mode, the header of Test Header no longer appears. It will 
only appear on the printed page. 
 
Footers are generally used for page numbers and to place a time and date stamp on the printed 
worksheet. Like headers, these only appear on the printed page(s). 
 
Access Footers in the same manner by going to the Insert menu option and then selecting Header 
& Footer which is toward the right hand side of the toolbar. 
 
Once again, the Header & Footer Tools Design toolbar appears. On the left hand side of this 
toolbar is the Footer option button. 
 

 
 
When the Footer button is selected, you’ll note several different standard options (e.g., page 
number, current date, author, etc). Using the other buttons to the left, you may also select 
multiple options such as page number and current date. You may also select page number, 
current date, and current time. 
 
For printed documents, a page number is important to ensure that multi-page documents don’t 
get out of order. You may also want a date and time on the document if it happens to be one of 
those documents that endures constant revisions. A budget or forecast document is an example of 
this. It may be printed out, reviewed and then “tweaked” multiple times in an hour. In these 
instances, you want to ensure that you’re working with the most recent printed document. Once 
again, neither headers not footers show up on the worksheet displayed on the computer monitor. 
They only show up on the printed document. 
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To place page numbers, date, and time as a Footer, scroll down until the footer portion of the 
worksheet is displayed and click on the Footer section. 
 

 
 
Once the left Footer section has been clicked, select the Page Number button from the toolbar. 
Your Footer area should now appear as follows: 
 

 
 
Next, click on the middle footer section and select the Current Date button from the toolbar.  In 
the right footer section, select the Current Time button from the toolbar.  The completed footer 
should have &(Page) on the left, &(Date) in the middle and &(Time) on the right. 
    
If you are using an earlier version of Excel that does not have left, middle and right header 
sections, this is the solution: 
Click the &(Page), &(Date) and &(Time) buttons.  They will display in the middle of the footer 
in a group.   
 
Remain in the Footer area and click in between &[Page]&[Date] and add some spaces. Also add 
some spaces between &[Date]&[Time]. Simply use the spacebar. If these are not spaced, they 
will run together and be difficult to read. The finished product should look something like this. 
 

 
 
Click anywhere in the worksheet and, while in page layout mode, you can see the results. 
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To return to the Normal page layout, click on the View menu option, and select the Normal 
option on the left hand side of the toolbar. 

 
 
Once back in the Normal page layout mode, the footer no longer appears. It will only appear on 
the printed page. 
 
Headers and Footers can be important to documenting printed worksheets. However, keep in 
mind that the Headers and Footers only appear in the printed form and are not displayed in the 
worksheet on the computer monitor. They should be used with this in mind. 
 
Print Titles 
If you want a heading to appear on both the worksheet as viewed and the printed page, an easy 
way is to use the top row(s) of the worksheet for a heading and then use an Excel tool called 
Print Titles to ensure that each printed page has the same heading. 

• Open a new worksheet. 
 
As an example, enter the text Test Header in cell A1. 
 

 
 
Select the Page Layout menu option, then select Print Titles toward the middle of the toolbar. 
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After Print Titles has been selected, a textbox appears. 
 

 
 
Using the Rows to repeat at top: option, enter 1:1 (indicating a range of the first row to the first 
row. If you just enter 1, it won’t work.), then click OK at the bottom. 
 
Note that by using this alternative, the header may encompass more than one row. It can be two 
or more rows of description. 
 
If the worksheet encompasses multiple pages, the heading would now be Test Header on all 
printed pages. 
 
This alternative ensures that the heading is displayed on both the printed worksheet as well as on 
the worksheet being displayed on the computer monitor. Depending on the predominant use of 
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the worksheet, printed or viewed on a monitor, either Headers or Print Titles should be utilized to 
describe the purpose of the worksheet. 
 
Worksheet Design 
 
Input Data Check Totals 
All input data must be tied out to an authoritative source. In order to do this, totals should be 
used to ease this process. It is easy to skip this step as many will trust the data downloaded from 
an enterprise computer system. However, this is an extremely important step that acts as an 
internal control over the output data. 
There must be a process to ensure the input data is correct. Without any controls over the input 
data, there can be no assurance that the output is correct. There is an old information technology 
expression that is applicable here: Garbage In, Garbage Out (GIGO). If the wrong data inputs are 
used, the output will also be wrong. 
 
As an example, if product sales by model number for the previous year was the input data, the 
total sales should tie out (or be reconciled) to prior year reported sales. If year-end inventory by 
product is the data input, that should also tie out (or be reconciled) to prior year reported 
inventories. Check totals should always be available and these totals should always be compared 
to reported amounts to ensure accuracy of the inputs. 
 
There are numerous instances of reports and analyses being wrong due to the use of incorrect 
data inputs. The use of check totals and the subsequent comparison of the check totals to 
reported amounts or another authoritative source is the best assurance that the appropriate input 
data is being utilized and this data is complete. 
 
Formulas Require Cell References Rather Than Numbers 
A previous example used numbers in a formula rather than cell references. Note that the 
Forecasted Sales in cell B4 uses actual sales multiplies by a factor of 1.2 to obtain actual sales. 
 

 
 
This is not a good practice. While it is tempting to use a worksheet as a calculator for keystroke 
efficiency, it is not a good practice in worksheet design for the following reasons: 

• The calculation methodology is not evident. Just looking at the analysis, it is unclear that 
a factor of 1.2 is being applied to Actual Sales. 



Excel Worksheets: Best Practices  
 

24 

• The use of 1.2 in the formula is subject to data entry error. A factor of 1.3 could easily be 
entered in error and unless someone recalculated the Forecasted Sales, this error is 
unlikely to be caught. 

• If the factor of 1.2 was changed, it would require editing of 4 different cells, also 
resulting in a much higher likelihood of error due to erroneous input. The new 
assumptions would also not be clear to a reader of the worksheet.  

 
As noted earlier, it is also not a good practice from a worksheet layout perspective as the 
underlying assumptions to arrive at Forecasted Sales are not evident to the reader or the preparer. 
The best practice is to have formulas use cell references rather than numbers. By following this 
practice, the amounts may be reviewed for accuracy in case of data input errors, may be 
reviewed for reasonableness, and may be easily changed with a higher level of assurance that the 
proper changes were made.  
 
Using the same example, a best practice worksheet would be: 
 

 
 
In this example, the growth assumptions are in separate cells that are referenced by the formula. 
They may be easily reviewed and changed. The use of this technique helps to ensure calculation 
accuracy. 
 
Use Constraints in Calculations 
All calculations need a sanity check. There are times when calculations are performed and the 
answer just doesn’t make sense. Key worksheet calculations should be subject to constraints that 
highlight any answers that just don’t make sense. 
 
As an example, assume that a worksheet is being used to prepare a General and Administrative 
Expense budget. Each department is preparing its own budget and the purpose of the worksheet 
is to summarize the departmental inputs. Wouldn’t it be nice to know if any expense line item 
increased by more than 10% over current year forecast so that particular line item could be 
investigated? 
 
By using constraints, the preparer can identify results that don’t appear to make sense and subject 
these results to further investigation. The investigation may demonstrate that there is a problem 
with the input or it may highlight an error in calculation. Even if there is no error present, it 
prepares the worksheet preparer with an answer in the event someone else questions to result. 
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Assume that the following represents the culmination of the budgeting process for General and 
Administrative Expenses.  

• Open the Worksheet Best Practices workbook and select the tab labeled Constraints.  

 
 
Now, both the preparer and reader could scan the % Increase (Decrease) column to see that there 
are outliers. However, if the information presented was much greater or if there are time 
constraints, this review may be susceptible to error. Since the overall increase of 7% may appear 
to be reasonable, the increases in Supplies of 44% and Advertising of 50% may escape notice. 
There are two ways to apply constraints to identify any increase greater than 10%. The first is to 
use the IF function. The syntax for the IF function is: 
 

=IF(logical test, value if true, value if false) 
 
The logical test is the condition you wish to use to select. In this case, the test would be whether 
than % Increase Decrease in column D is greater than 10%. The value if true is the value that 
will be returned if the logical test is true (The value in column D is greater than 10%). This value 
may be a number or text. In this example, we’ll use text that states “Large Increase.” The value if 
false is the value that will be returned if the logical test is false (The value in column D is less 
than or equal to 10%). This value may also be a number or text (If it is text, the text value must 
be in quotes). Since we’re not concerned with values that are less than or equal to 10%, we’ll use 
a blank space ("") for this value. 
 
In cell E5, the formula will be inserted as shown below. 
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After pressing Enter, there is a blank in cell E5. This is expected as the increase is not greater 
than 10%. When this formula is copied down from E5:E13, the results are shown below. 
 

 
 
Now, the large increases in Supplies and Advertising are highlighted for further review. The use 
of constraints in calculations makes the review process easier and reduces the possibility of 
calculation error. 
 
Another method that may be employed is the use of conditional formatting. The Conditional 
Formatting option can be found on the Home menu, just right of center on the toolbar. 
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To use Conditional Formatting to accomplish the goal of highlighting all amounts in column D 
that are greater than 10%, highlight the range of cells from D5:D13. 
 

 
 
Click on the Conditional Formatting button, then select Highlight Cells Rules, then select 
Greater Than (since we want those cells that are greater than 10%). Note that there are other 
options which include Less Than, Between and Equal To. These options will work in the same 
manner as described below. 
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The following dialog box appears. 
 

 
 
Replace the 25% in the dialog box with 10%. On the right, there are highlighting options. You 
can use the six standard fill and text options or you can customize both the text color and/or the 
fill color. We will use a yellow fill for any amounts greater than 10%, so click on Custom 
Format. 
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When the Format Cells dialog box appears, select the Fill tab, if this is not already selected. 
Click on the yellow fill color. The sample at the bottom should now display a bar of yellow 
color. Click OK. 
 
Click OK on the Greater Than dialog box. 
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The two items that are greater than 10% are now highlighted in yellow to indicate that further 
review is necessary. The use of either Conditional Formatting or the IF function as constraint 
tools to identify results that are beyond reasonable expectations is an important technique to 
assure that both data inputs and the results of calculations are accurate. 
 
Use Comments to Explain Calculations 
As noted earlier, comments are an important tool to explain how the worksheet operates. You 
may easily add a new comment by going to the Review menu option and clicking New Comment 
on the toolbar. 
 

 
 
When New Comment is clicked, you have a yellow area to add text (or, in newer versions of 
Excel, a text box). 
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To continue with the Sales Forecast example, the comment explains that the calculation is the 
result of multiplying the actual sales by (1+Growth%) that are in the Growth Assumptions area 
of the worksheet.  
 

 
 
Comments may be displayed by either hovering over the cell with the cursor or by clicking the 
Show All Comments option on the Review menu. 
 

 
 
Comments may also be printed. When preparing the worksheet for printing, select Page Setup 
and then select the Sheet tab. On the middle portion of the right side of the dialog box is the 
Comments options. You may elect to either print the comments at the end of the sheet or print 
them as displayed on the worksheet. A word of caution, printing the comments as displayed on 
the worksheet may obscure some of the output. 
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The use of check totals, cell reference inputs in formulas and calculation constraints will help to 
assure that the worksheet is functioning as intended. As noted earlier, documenting key 
calculations, assumptions, and data sources is essential to reminding the preparer of what was 
done long ago as well as helping another user with the worksheet components.  
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Review Questions 
 
The review questions accompanying this course are designed to assist you in achieving the 
course learning objectives. The review section is not graded; do not submit it in place of your 
qualified assessment. While completing the review questions, it may be helpful to study any 
unfamiliar terms in the glossary in addition to course content. After completing the review 
questions, proceed to the review question answers and rationales. 
 
1. Which of the following is an acceptable range name in Excel? 

 
a. Total_Expense 
b. Total-Expense 
c. Q1 
d. Net Income 

 
2. Comments may be printed: 

 
a. By right-clicking any cell in the workbook 
b. By clicking the Review tab and then clicking Show Comments 
c. By accessing the Print menu, selecting Page Setup, then selecting the Sheet tab and 

selecting a print option in the Comments box 
d. By selecting a separate page at the end of the worksheet 

 
3. Which of the following is not true regarding calculation constraints? 

 
a. They may be accomplished using the IF function 
b. 10% variance is always a good constraint 
c. They may be accomplished using Conditional Formatting 
d. They are used to identify outliers 
 

4. Which of the following is not a best practice for worksheet design? 
 
a. Use check totals for input data 
b. In cases where there is a significant amount of data and analysis, make sure that all 

inputs, calculations and output fit into one worksheet to ease review 
c. Use cell references in formulas rather than numbers 
d. Use calculation constraints   
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Worksheet Audit and Other Tools to Ensure Accuracy 
 
Data Validation 
If the worksheet requires user input, validation of user input is a best practice. While Excel 
cannot test to make sure that any entry is absolutely accurate, it can test for a value that is a 
whole number, decimal, a list, a date, a time, text, or a custom formula. Except for the list option 
and custom formula, you can further restrict the input to a range of values.  
To access Data Validation: 

• Open a new worksheet 
• Select the Data tab 
• Select the Data Validation button 
• Select the Data Validation option 

 

 
 
As an example, if the input to a cell is a date that should be restricted to the year 2015, which 
would be accomplished by selecting the cell, then selecting the Data Validation button, selecting 
the Data Validation option, then, from the list that appears after “Allow:” in the dialog box, 
select Date. 
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Once Date has been selected, the following dialog box appears: 
 

 
 
You have many logical options now. The date can be between two dates, not equal to a date, not 
between dates, greater than, or less than a date. You have similar options with the other values 
(except List and Custom).  

• For our purposes, we’ll confine the date in this cell to 1/1/2015 – 12/31/2015. Use the 
between option under Data: then enter these values in the start date and end date 

• Press OK. 
 
Now, this cell (A1 in the example) will be restricted to a date that is between 1/1/2015 and 
12/31/2015. When we attempt to input 12/31/2009 into the cell, we see the following: 
 

 
 
Press Cancel.  
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Now, we can make this more user friendly by using an input message. That is on the second tab 
of the Data Validation tool.  

• After selecting the Data Validation button and selecting the Data Validation option again, 
click on Input Message tab on the Data Validation dialog box and enter the 
information shown in the screenshot below. 

 

 
 

• Click OK 
 

When we click OK, the message appears whenever the cell (A1 in this example) is selected. It 
looks like this: 
 

 
 
You can also customize the error message by selecting the third tab on the Data Validation tool.  

• Select the Data Validation button and select the Data Validation option 
• Click on the Error Alert tab in the Data Validation dialog box 
• Enter the information shown below: 
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• Press OK  
• In that cell, enter erroneous data (like 12/31/2009) and the following appears. 

 

 
 
The logic is the same for numbers. This is a great tool help check user input for keypunch errors.  
The error alert will default to a Stop condition. This is the desired setting since this will prevent 
input that does not meet the data validation settings. The other two settings (Warning and 
Information) will allow the user to input data that does not meet the validation settings and 
provides a warning message. It is recommended that the default Stop setting be used. 
 
Note: There is a weakness in data validation. If data is copied to the cell subject to validation, the validation does 
not work as the cell contents have been replaced. User documentation should reflect that data must not be copied to 
a cell that has Data Validation applied. 
 
If the input can be restricted to a specific list, this can “error proof” it even further. Assume that 
the input to cell A1 is confined to the 12 months Jan-Dec. We want the input to A1 confined to 
these values.  

• Once again, select the Data Validation button and then select the Data Validation 
option. This time select List from the dialog box options. 
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It will ask for a source for the list.  

• Cancel the Data Validation 
• In cells D1:D12, type Jan, Feb, Mar, Apr…Dec. to use that as the source for data 

validation  
• Select Data Validation and List again  
• For the source, use =$D$1:$D$12. (You can also select the range by clicking on the 

spreadsheet box to the right of the input box and using your mouse to select the range).  
•  Click OK. 
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• Go to cell A1.  
 
 You have the following drop down options: 
 

 
 
Now you can only select one of the pre-set items. With this, you can also use a customized input 
message and error message as shown above. 
 
The big advantage of using lists is to restrict the input to a pre-selected range. However, another 
advantage of using lists is the uniformity of the data being presented. In the example, January 
will always be presented as Jan. 
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Another feature is the custom formula. The most common use for this is to restrict the input 
value of a cell based on the value of another cell in the spreadsheet. As an example, say that a 
component of a spreadsheet calculates the minimum liability exposures of a lawsuit in cell D12 
and you want the input value of cell A1 to not be less than this computed amount.  
  
Let’s assume that the value in cell D12 is 1,000,000.  

• Select the Data Validation button and then select the Data Validation option 
• Select Custom from the dialog box 
• In the formula box, type =if(A1<D12,False,True)  

o This will limit the input in cell A1 to an amount that is greater than or equal to the 
result in cell D12. 
 

 
 
If you enter the value 999,999 in cell A1, you will get an error message as this amount is less 
than 1,000,000. 
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This formula tells Excel that if the condition is true (the value of A1 is less than the value of 
D12), then return False (an error condition), otherwise return True (a non-error condition). 
 
Note that this may also be accomplished by selecting a “whole number” that is “greater than or 
equal to” 1,000,000 in the dialog box as shown below. 
 

 
 
Once again, input messages and error messages can be customized. Keep in mind that the Error 
Alert should remain at Stop. 
 
While Data Validation is not error proof, you can restrict user input to ensure that many, if not 
most, inadvertent input errors are detected.  Also be aware of the weakness of data validation; 
data may be copied into the validated cell, replacing the cell contents. 
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Cell Protection and Worksheet Protection 
If there are key calculations that should not be changed, cell protection in Excel allows you to 
lock cells and restrict access to those cells. This can be used to protect formulas, functions and 
calculation detail. Many times, the only unlocked cells in a spreadsheet are those that are used 
for user input.  
 
A locked cell can be password protected. It is important to note that the password protection is 
not the default. It is important to limit the password to only those users with authorized access, to 
properly safeguard the password and not share it with anyone else. 
 
In cells, the default setting for cells is that they are locked. You can access the protection settings 
for a cell or range of cells through the Home tab, Cells Format or by right clicking a cell or range 
of cells and going to Format cells. Both methods are illustrated below. 

• Select Format icon from the Home tab: 
 

 
• Click Format Cells 
• Select the Protection tab  
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Alternatively, you can right-click on a cell or group of cells: 
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When you click Format cells and select the Protection tab, the following appears: 
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Note that both methods arrive at the same result. Also note that the default option is that the cells 
are locked.  
 
Nothing happens to a locked cell until the worksheet is protected. You can access the worksheet 
protection window one of two ways. Either go to the Review tab, click Protect Sheet or use the 
Home tab, Click Format and then Protect Sheet.  
 
In either instance, you arrive at the following:  
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The default option is that users can select both locked and unlocked cells. Assume that you want 
to protect the contents of the entire sheet except for cell A1, which is an input cell. Since we 
know that the default option is that cells are locked, we need to unlock cell A1. Using one of the 
methods described above,  

• Click Cancel on the dialog box, above 
• Click on cell A1 
• Get to the Format cells dialog box using one of the methods described above 
• Select the Protection tab as shown below: 
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Note that cell A1 is locked (Default option).  
• Click the checkmark to unlock it.  
• Once the box is empty, click OK. 

 

 
 
After OK is clicked, cell A1 should be unlocked while the other cells are locked.  
Let’s test this by protecting the worksheet. Using one of the methods identified above, go to the 
Protect Sheet window.  
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• Click the box Select locked cells to clear the checkmark. This will allow users to only 
select unlocked cells (as that’s the only box that will be checked).  

• Once you have unchecked the Select locked cells box, click OK. 
 
Now, try to select any cell in the worksheet other than A1. It doesn’t work. You can only select 
cell A1.  
 
You can turn this off by unprotecting the worksheet. To do this, 

• Go to the Review tab, Changes and click Unprotect Sheet as shown below. 

  
 
When the sheet is unprotected, all cells are once again accessible. 
To prevent unauthorized changes to cells that contain formulas or calculations, you can password 
protect the worksheet so that it may be unprotected by only those that know the password. To do 
this, go back to the Protect sheet window and before clicking OK, type in a password. As an 
example, we’ll use the password bear. 
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Note that passwords should be strong. It is recommended that they be at least 7 characters long, 
contain both uppercase and lowercase letters as well as number and symbols. Our use of the 
password bear is for illustrative purposes only. 
 

 
 
After clicking OK, you will be prompted to re-enter the password. After that, the sheet can only 
be unprotected by the password bear. You will be prompted when you try to unprotect the sheet 
as shown below. 
 

 
 

• Type bear and click OK.  
The worksheet is now unprotected. 
 
Tip: To find unprotected cells in a protected worksheet, simply press the Tab key 
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Workbook Passwords 
To ensure that unauthorized users do not access a workbook, a workbook can be password 
protected. Without the password, users cannot access the worksheets within the workbook. It is 
an effective control as long as the password is limited only to those users with authorized access, 
is properly safeguarded and is not shared with anyone else. A password is not very effective if 
it’s on a sticky note attached to your computer monitor. 

• Click on File  
• Click Info 
• Select Protect Workbook  

 

 
 

• Click Encrypt with Password 
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Note the contents of the message above. If you lose the password, it cannot be recovered. Also 
note that passwords are case sensitive.  
 
Once you’ve selected a password, you’ll be asked to re-enter it. 
 

 
 
When you save the workbook, the password will be required to open it. Again, keep in mind that 
there is no way of recovering a lost password in Excel. 
 
This feature not only password protects the workbook. It also uses AES 128-bit encryption 
which makes the file more secure. Again, it is important to note that passwords should be strong. 
They should be at least 7 characters long and contain both uppercase and lowercase letters as 
well as numbers and symbols.  
 
This is one way of addressing the compensating control of access to the spreadsheet is limited to 
authorized users. An additional control can be found in the information technology function’s 
network access control. If the spreadsheet is in an area of the network that only authorized users 
can access, and the network access controls are effective, that will also accomplish the task of 
limiting the spreadsheet to authorized users. 
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Highlighting All Cells Containing Formulas 
Before we use the formula auditing tools, it’s important to first identify all the cells that contain a 
formula. The Home tab contains an editing section. Click on Find & Select and the following 
options appear. 
 

 
 
Click on Go To Special… 
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Click on Formulas. This will identify every formula in the spreadsheet. You may also limit 
which types of formulas are returned. However, in this example, we want them all. 

• Open the Worksheet Best Practices workbook and select the Formulas tab. 
 

 
 
Using the method described above: 

• Go to the Home tab 
• Click on Find & Select 
• Click Go To Special… 
• Click Formulas 
• Click OK.  
• The three formulas are now selected. 



Excel Worksheets: Best Practices  
 

54 

 
 
To make the selected cells more evident, use a fill color. In this example, we’ll use yellow. 
 

 
 

• Click on the Fill Color button and now the selected cells are highlighted yellow. 
 

 
 
It is now evident to a reviewer which cells contain formulas. 
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Trace Precedent and Dependent Cells 
You can trace both precedent cells and dependent cells of formulas and see where the data is 
coming from or where it’s going to. Let’s start with the precedent cells of a formula or where the 
data is coming from. 

• Using the example above, click on highlighted cell A7.  
• Go to the Formula tab and click on Trace Precedents.  

 

 
 
The following appears. 
 

 
 
You see that the formula is comprised of cells A1:A6. However, it may be helpful to also see the 
formula.  

• Click Show Formulas in the Formula tab as shown below...  
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You see the following: 
 

 
 
Formula auditing also traces formulas that use information from different worksheets. Using a 
new worksheet, we’ll sum another column of numbers and refer to that column in the existing 
example. The column of numbers on a separate sheet follows. 
 

 
 

• In cell A9, we’ll reference that sum in cell A7 of the separate worksheet.  
• The result is below. 
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Since the Show Formula option is engaged, we see the actual formula in cell A9. 

• Click on cell A9, then click Trace Precedents. 
 

 
 
The trace line ends at a worksheet icon. When you double click the line, a window appears that 
tells you where the data is coming from. In this case, Sheet2, cell A7. 
 
Trace dependents tell you where the data is going to. If you click on a cell with data in it, it will 
tell you where the formula is that uses the data. Using our same example in cells A1:A7, click on 
cell A1, then click on Trace Dependents in the Formulas tab. 
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You can see that the data in cell A1 is used in the formula in cell A7. 
 
To remove the arrows and the formulas, click on Remove Arrows and also click on Show 
Formulas. The spreadsheet should revert back to normal. You can manually remove the 
highlights on the formula cells by returning to the Home tab, Find & Select, Go To Special and 
once again finding all the formulas. After they have been selected, click on the Fill Color button 
and choose No fill. Now, everything is back to normal. 
 
Tip: A shortcut is to press F5 and select Special from the bottom of the dialog box. 
 
Error Checking 
Excel can also help with determining whether errors exist. The Error Checking tool uses certain 
rules to check for problems in formulas. These rules do not guarantee that your worksheet is 
problem-free, but they can go a long way to finding common mistakes.  
 
Using the same data we had before: 

• Change cell E7 to only sum E2:E6, ignoring cell E1.  
 
The spreadsheet looks like this: 
 

 
 

• Now, click on the Formulas tab and click Error Checking. The following appears. 
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We have options. We can update the formula to include the excluded cell, ignore the error, or 
manually edit it in the formula bar. If there are multiple errors, we can also proceed to the next 
error. In this case, we will Update the Formula to Include Cells. A message box appears that tells 
us that error checking is complete. 
 
Error checking will also help identify error values which are normally preceded with a # such as 
#N/A, #Value!, #DIV/0!, #Name?, #Ref!.  
 
Watch Window 
A watch window can also be added to monitor a cell and its formula while you work, even when 
the cells are not visible on the screen. Watching a cell can help you notice errors. This can be 
used for key calculation results in a test setting where the results have been previously calculated 
and you can watch for the same results.  
 
As an example, we’ll watch the results of cell E7.  

• Select cell E7 
• Click the Formulas tab, then the Watch Window button. 
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• Click Add Watch. 
 

 
 

• The default cell is the one already selected, E7. Click Add. 
 

 
 

Our watch window now monitors cell E7 and provides its current value and its formula. If the 
value changes, we can monitor the change to ensure it is what we expected. 
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Review Questions 
 
The review questions accompanying this course are designed to assist you in achieving the 
course learning objectives. The review section is not graded; do not submit it in place of your 
qualified assessment. While completing the review questions, it may be helpful to study any 
unfamiliar terms in the glossary in addition to course content. After completing the review 
questions, proceed to the review question answers and rationales. 
 
5. Data Validation is UNABLE to: 

 
a. Handle a list of acceptable user inputs 
b. Limit user input to a range between two dates 
c. Restrict user input to a number greater than 50 
d. Error proof user input 

 
6. Which of the following will only protect cell A1 from changes, but permit the worksheet 

user to access and change other cells in the worksheet? 
 

a. Protect Sheet 
b. Lock cell A1, then Protect Sheet 
c. Unlock all cells other than A1, then Protect Sheet 
d. Unlock all cells other than A1 

 
7. Which of the following is true regarding workbook passwords? 
 

a. There is a test in Excel for password length, use of a number and use of a special 
character 

b. There is no way of recovering a lost password in Excel 
c. Passwords are NOT case sensitive 
d. You only must enter the password once 

 
8. Which Excel feature will tell you where formula data is coming from? 

 
a. Trace dependents 
b. Watch window 
c. Error checking 
d. Trace precedents 
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Review Question Answers and Rationales 
 
Review question answer choices are accompanied by unique, logical reasoning (rationales) as to 
why an answer is correct or incorrect. Evaluative feedback to incorrect responses and 
reinforcement feedback to correct responses are both provided. 
 
1. Which of the following is an acceptable range name in Excel? 

 
a. Correct. Range names must start with a letter or an underscore. The range 

name Total_Expense starts with a letter. Only letters, numbers, underscores, 
and periods may be used after the first character.  

b. Incorrect. While the first character is a letter (and may be either a letter or 
underscore), Total-Expense contains a hyphen. This character is not permitted as only 
letters, numbers, underscores, and periods may be used after the first character. 

c. Incorrect. Q1 represents a worksheet cell reference. Cell references are not permitted 
as a range name. 

d. Incorrect. Net Income contains a space. Spaces are not allowed within range names. 
Only letters, numbers, underscores, and periods may be used after the first character. 
 

2. Comments may be printed: 
 
a. Incorrect. By right clicking any cell in the workbook you only have the option to 

insert a comment into the worksheet. There is no option to print the comments. 
b. Incorrect. By clicking the Review tab and then clicking Show Comments will display 

the comments on the computer monitor. However, this step will not print the 
comments. 

c. Correct. By accessing the Print menu, selecting Page Setup then selecting the 
Sheet tab and selecting a print option in the Comments box will result in a 
printed page that contains the worksheet comments either printed as displayed 
on the sheet or at the end of the worksheet. 

d. Incorrect. Comments may be printed as they are displayed on the worksheet or at the 
end of the worksheet.  
 

3. Which of the following is not true regarding calculation constraints? 
 
a. Incorrect.  The IF function is a method of providing calculation constraints.  It is used 

to identify results that may be greater than, less than, equal to, not equal to (along 
with a variety of other conditions) a certain parameter. 

b. Correct.  The use of a 10% variance may be a good constraint in certain 
circumstances.  However, it is not always a good constraint.  When dealing with 
large numbers, a constraint of 2% may be needed.  You may also wish to use a 
numeric constraint such as a variance of $500,000.  The constraint is dependent 
on the circumstances and professional judgment. 

c. Incorrect.  Conditional Formatting is an accepted method of providing calculation 
constraints.  It highlights results that are greater than, less than, between, equal to, has 
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text containing (and a variety of other conditions) a specified parameter.  It highlights 
the results, providing easy visual identification of the outlier.  

d. Incorrect.  Calculation constraints are used to identify outliers, making this a true 
statement.  Identification of outliers provides a method of reviewing calculation 
output to help ensure that the calculations are performing as intended. 

 
4. Which of the following is not a best practice for worksheet design? 

 
a. Incorrect.  The use of check totals for input data is a best practice.  This eases the 

process of comparing the total of input data to an authoritative source, helping to 
ensure the accuracy of the input data.  

b. Correct.  In cases where there is a significant amount of data and analysis, inputs, 
calculations and output should be segregated to multiple worksheets within a 
workbook and each worksheet should be properly labeled.  This will ensure that 
proper separation of input data, assumptions, calculations and output.   

c. Incorrect.  The use of cell references in formulas rather than numbers is a best 
practice.  This helps both the preparer and reviewer easily see that formula inputs and 
changes may be made in a more controlled manner. 

d. Incorrect.  Calculation constraints are a best practice to detect any outliers that may 
represent formula issues or bad data inputs.     
 

5. Data Validation is UNABLE to: 
 
a. Incorrect. Data Validation is able to handle a list of acceptable user inputs. This is 

accomplished by using the list feature in the Allow: portion of the Data Validation 
dialog box. 

b. Incorrect. Data Validation is able to limit user input to a range between two dates. 
This is accomplished by using the Date feature in the Allow: portion of the Data 
Validation dialog box and the Between feature in the Data: portion of the Data 
Validation dialog box. The two dates must also be specified in the dialog box. 

c. Incorrect. Data Validation is able to restrict user input to a number greater than 50. 
This is done by specifying a whole number in the Allow: portion of the Data 
Validation dialog box and Greater than in the Data: portion of the data validation 
dialog box, then specifying the number 50 as a Minimum. 

d. Correct. Data Validation is unable to absolutely error proof user input. It can 
create certain restrictions on user input that will help to minimize errors. 
However, there can still be erroneous input within the confines of the Data 
Validation parameters. As an example, if the number entered must be greater 
than 50, and was meant to be 55, but 65 was entered in error, the Data 
Validation parameters would not catch this error. 
 

6. Which of the following will only protect cell A1 from changes, but permit the worksheet 
user to access and change other cells in the worksheet? 
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a. Incorrect. The use of Protect Sheet only will result in all cells being protected in their 

default value, which is locked. In this case, all the cells in the worksheet would be 
inaccessible and unable to be changed. 

b. Incorrect. Since the default value of all cells is locked, by (re) locking cell A1, then 
protecting the sheet will also result in all cells in the worksheet being locked and, 
therefore, inaccessible and unable to be changed.  

c. Correct. The default value of all cells in locked. By unlocking all cells other than 
A1, it changes these cells from the locked value to the unlocked value. When 
Protect Sheet is engaged, cell A1 will still be locked and all other cells will be 
unlocked and accessible to the user. 

d. Incorrect. While unlocking all cells other than A1 is a good first step, it omits the step 
of engaging Protect Sheet. If Protect Sheet is not engaged, the locked cells will not be 
locked. In this case, all cells, including A1, would be accessible to the user and able 
to be changed. 
 

7. Which of the following is true regarding workbook passwords? 
 
a. Incorrect.  There is no test that Excel administers for password length or the use of 

numbers or special characters.  There are suggestions in the course for this, but no 
specific test is performed by Excel.   

b. Correct.  There is no way to recover a lost password in Excel.  Because the 
encryption is very strong, you may not be able to access the file again if the 
password is lost.  This is an important element to remember when using 
passwords.   

c. Incorrect.  Passwords in Excel are case sensitive.  While there is no test for password 
length or the use of numbers or special characters, there is a comparison of uppercase 
vs. lowercase letters.  A simple password like “bear” would be different from “Bear” 
because of the capital B.   

d. Incorrect.  Excel requires that a password be entered twice before it is accepted.  This 
is to safeguard against misspelling or typing errors.  Since there is no way to recover 
a lost password in Excel, this feature is used to ensure that the typed password is the 
one that was meant to be used. 
 

8. Which Excel feature will tell you where formula data is coming from? 
 
a. Incorrect. Trace dependents tells you which formula data is going to. If a data cell is 

selected, Trace dependents will display an arrow to the formula(s) that contain the 
data in the selected cell. 

b. Incorrect. A Watch window can be added to monitor a cell’s value and its formula 
while you work. However, it does not show where data is coming from. 

c. Incorrect. The Error checking tool uses certain rules to check for problems in 
formulas. While it may highlight a possible problem in a formula, it does not indicate 
the source of formula data. 
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d. Correct. Trace precedents shows you where formula data is coming from. When 
a formula cell is selected, Trace precedents will use an arrow to indicate the data 
used in the selected formula. 
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Glossary 
 
This is a glossary of key terms with definitions. Please review any terms with which you are not 
familiar. 
 
Absolute cell references: The use of $ signs that precede the column and row references and 
make a column or row reference, or both, fixed. This is important when copying formulas that 
contain cell references. Without absolute cell references, the formula cell references will change 
as the formula is copied. The absence of absolute cell references is called relative cell references.  

Comments: A method to document Excel worksheets that involves adding dialog to a particular 
cell. The dialog may be displayed on the worksheet as the cursor hovers over the worksheet and 
may also be printed as displayed on the worksheet or at the end of the worksheet. 

Constraints: A way to identify formula results that do not conform to expected results. Using 
the IF function or conditional formatting, results that are outside of expectations may be further 
investigated to ensure worksheet formulas are functioning as designed. 

Data Validation: An Excel tool that confines user input to certain set parameters.  

Footer: The bottom of a printed worksheet page. This area may contain page numbers, current 
date and time, author and other information.  

Header: The top of a printed worksheet page. This area may contain a title for the worksheet as 
well as other information. 

Locked cell: When Protect Sheet is engaged, a cell that may not be accessed or changed. The 
default for all cells is that they are locked. 

Named range: An individual cell or group of cells that is given a separate, more descriptive 
name in a worksheet. A named range is absolute in terms of its location reference.  

Protect Sheet: A means to make those cells that are locked unable to be accessed or changed 
when engaged. 

Unlocked cell: A cell that may be accessed or changed when Protect Sheet is engaged. 
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Qualified Assessment 
Excel Worksheets: Best Practices  
Course # 2174596, Version 2007 

Publication/Revision Date: 
July 2020 

 
Course Expiration Date 
Per AICPA and NASBA Standards (S9-06), QAS Self-Study courses must include an expiration 
date that is no longer than one year from the date of purchase or enrollment. 
 
Complete this assessment online at www.westerncpe.com and receive your certificate and results 
instantly! 
 
1. Which of the following is NOT a good worksheet layout practice? 

 
a. Use of descriptive headings 
b. Separate calculations from assumptions on the worksheet 
c. Use comments 
d. Color code certain inputs and outputs with no legend describing the color coding 

scheme 
 

2. To copy a formula using one cell as an input cell, which Excel feature will maintain the 
cell reference of the input cell without changing it as it is being copied down or across? 
 
a. Relative cell referencing 
b. Absolute cell referencing 
c. Data Validation 
d. Error checking 
 

3. Which of the following is NOT true regarding named ranges in Excel? 
 
a. They only apply to multiple cells.  Individual cells cannot be named 
b. They are automatically absolute references 
c. They are named using the Name Manager 
d. Names must begin with a letter or an underscore 
 

4. Which of the following is NOT true regarding worksheet comments? 
 
a. They may be added by right clicking on a cell and selecting Insert Comment 
b. Comments cannot be printed 
c. They may be added by selecting the Review tab and the New Comment button 
d. Comments are displayed when the cursor hovers over the cell 
 

5. You want to identify calculation results that are less than 1,000. Which Excel feature will 
accomplish this? 
 
a. Go To Special 

http://www.westerncpe.com/
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b. Data Validation 
c. Conditional formatting 
d. Name Manager 

 
6. Which of the following will identify the result of a calculation in cell A1 that is greater 

than 10? 
 
a. =IF(A1>10,"Greater than 10","") 
b. Format cells, then select Custom 
c. =IF(A1>10) 
d. Home tab, then Format as Table button 

 
7. You wish to restrict user input to a date in 2015. What is the best way to accomplish this? 

 
a. IF function 
b. Conditional Formatting 
c. Data Validation 
d. Insert Comment 

 
8. Which of the following is true regarding worksheet protection? 

 
a. The default is that cells are unlocked 
b. The default is that cells are locked 
c. Locked cells are always protected 
d. There is no password option 
 

9. A workbook password: 
 
a. Is restricted to a combination of letters and numbers 
b. Can be created by right clicking a cell 
c. Can be created by using the Home tab 
d. Cannot be recovered if forgotten 

 
10. Which Excel feature may be used to identify all formulas in a worksheet? 

 
a. Go To Special 
b. Name Manager 
c. Trace Precedents 
d. Watch Window 

 
11. Error checking: 

 
a. Guarantees that the worksheet is error free 
b. Will help identify certain common errors 
c. Does not let you proceed unless you correct the identified error 
d. Ignores error values preceded by a # 
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12. You are adding headers and footers to a worksheet. How do you return to a normal 

worksheet view? 
 
a. Review menu option, then select the Notes button 
b. Data menu option, then select the Group button 
c. View menu option, then select the Normal button 
d. Page Layout menu option, then select the Print Area button 

 
13. Which Excel feature is best described as a way to monitor a cell value and its formula 

while you work? 
 
a. Error checking 
b. Data Validation 
c. Name Manager 
d. Watch Window 
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Answer Sheet  
Excel Worksheets: Best Practices  
Course # 2174596, Version 2007 

2 CPE Credits 
 

 
Date: 

 
 

 
Name: 

 
 

 
Phone: 
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City: 

 
 

 
State: 

 
 

 
Zip: 

 
 

 
Fax: 

 
 

 
E-mail*: 

 
 

*E-mail address MUST be unique (not shared with another CPA) for Western CPE to grade your assessment 
 

Name of purchaser (if other than person taking assessment):  
 

If course was purchased as part of the MEGA TAX LIBRARY please include $4/credit for grading: 
VISA/MC/Discover/Amex #  Exp.  

 
 

Course expires 
1 Year from date 
of purchase or 

enrollment 
 

 Online Grading: visit www.westerncpe.com to complete your assessment 
online and receive your certificate of completion and results instantly. 

 
1. ___ 2. ___ 3. ___ 4. ___ 5. ___ 

6. ___ 7. ___ 8. ___ 9. ___ 10. ___ 

11. ___ 12. ___ 13. ___   
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Course Evaluation 
Excel Worksheets: Best Practices  
Course # 2174596, Version 2007 

 
Thank you for taking the time to fill out this course and customer experience evaluation.  Your responses help us to 
build better courses and maintain the highest levels of service.  If you have comments not covered by this 
evaluation, or need immediate assistance, please contact us at 800.822.4194 or wcpe@westerncpe.com. 
 
 
Course and Instructor Evaluation 
 
1. Please answer the following related to the content of the course: 
 
 Strongly 

Disagree Disagree Neutral Agree Strongly 
Agree 

The stated learning objectives were met.  O O O O O 

The course materials were accurate, relevant, and contributed 
to the achievement of the learning objectives.  O O O O O 

The stated prerequisites were appropriate and sufficient.  O O O O O 

Based on 50 minutes per credit hour, the time to take this 
course accurately reflects the credit hours assigned to it.  O O O O O 

The instructor was knowledgeable and effective.  O O O O O 

 
2. Were there any questions you felt were confusing or had incorrect answers listed?  If so, please give the 

question number and a brief description of the issue: 
 
 

 
3. Please provide any additional comments specific to the educational content or author of this course: 
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4. Do you have ideas for future course topics?  If so, please list them along with any known subject matter experts 
we might contact to develop the course: 

 
 

 
Customer Experience 
 
5. Please rate your overall experience with Western CPE: 
 
 

Unsatisfactory Improvement 
Needed 

Meets 
Expectations 

Exceeds 
Expectations Exceptional 

If you interacted with our Customer 
Service team, please rate the quality 
of service you received. 

O O O O O 

If you purchased your course online, 
please rate the quality of your e-
commerce experience. 

O O O O O 

“My Account” information includes 
the tools necessary to access courses 
and track those completed. 

O O O O O 

 
6. Please indicate the likelihood of your purchasing the listed course formats from Western CPE: 
 
 

Not at all Not very 
likely Possibly Likely Highly 

Likely 

Self-Study O O O O O 

Webcast OnDemand O O O O O 

Live Webcast O O O O O 

Resort Conference or Seminar O O O O O 
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7. Please use the box below to provide any additional comments related to your educational experience with 
Western CPE. 

 
 

 
8. If you are willing to provide a quote about this course, or Western CPE in general, that we may use in our 

promotional materials, please state it below.  Be sure to include your name, title, city, and state. 
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